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Chapter 1

Introduction

The T-Core presents a robust hardware design platform built around the Intel MAX 10 FPGA. The
MAX 10 FPGA is well equipped to provide cost effective, single-chip solutions in control plane or
data path applications and industry-leading programmable logic for ultimate design flexibility. With
MAX 10 FPGA, you can get lower power consumption / cost and higher performance. When you
need high-volume applications, including protocol bridging, motor control drive, analog to digital
conversion, and handheld devices, the T-Core MAX 10 FPGA is your best choice.

The T-Core development board includes hardware such as on-board USB Blaster 1I, QSPI Flash,
ADC-Header, WS2812B RGB LEDs and 2x6 TMD expansion header. By leveraging all of these
capabilities, the T-Core is the perfect solution for showcasing, evaluating, and prototyping the true
potential of the Intel MAX 10 FPGA.

T-Core also supports RISC-V CPU with on-board JTAG debug, it is an ideal platform for learning
RISC-V CPU design or embedded system design.

1.1 Package Contents

Figure 1-1 shows a photograph of the T-Core package.

o T-Core board
© Wini USB Cable
© Fiat Ribbon Cable

Figure 1-1 The T-Core package contents
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The T-Core package includes:
e The T-Core board
¢ USB Mini-B Cable
e Flat Ribbon Cable

1.2 T-Core System CD

The T-Core System CD contains the documentation and supporting materials, including the User
Manual, reference designs and device datasheets.

User can download this System CD from the web (http://T-Core.terasic.com/cd).

1.3 Layout and Components

This section presents the features and design characteristics of the board.

A photograph of the board is shown in Figure 1-2 and Figure 1-3. It depicts the layout of the board
and indicates the location of the connectors and key components.

MAX10 10M50DAF484

WS2812B 3-pin
USB Blaster Il ADC Header RGB LED Expansion Header x2
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5V Input
2-pin Header 2x6 TMD Header Key x2
(Reserved)
Figure 1-2 Development Board (top view)
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MAX10/RISC-V JTAG Config
Figure 1-3 Development Board (bottom view)

This board has many features that allow users to implement a wide range of designed circuits, from
simple circuits to various multimedia projects.

The following hardware are provided on the board:

FPGA Device

¢ MAX 10 10M50DAF484C7G Device
e Integrated dual ADCs, each ADC supports 1 dedicated analog input and 8 dual function
pins
¢ 50K programmable logic elements
¢ 1,638 Kbits MO9K Memory
5,888 Kbits user flash memory
¢ 144 18 <18 Multiplier
o4 PLLs
Programming and Configuration

e On-Board USB Blaster Il (Mini USB connector)
Memory Device

¢ QSPI Flash (Support RISC-V)
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Connectors

¢2x6 TMD GPIO Header

¢ 1x10 ADC Header

¢\WS2812B RGB LED Expansion Header
Switches, Buttons and LEDs

¢4 Green LEDs

¢4 Dip Switches

e 2 Push Buttons with Debounced.

¢4 WS2812B RGB LED
Power

¢5V DC input from USB or external power connector.

1.4 Block Diagram of the Board

Figure 1-4 gives the block diagram of the board. To provide maximum flexibility for the user, all
connections are made through the MAX 10 FPGA device. Thus, the user can configure the FPGA to
implement any system design.

MAX10/RISC-V
JTAG Enable/Disable

RISC-V JTAG | sv

QSPI

Flash “

(RISC-V) . Ws2812B
WS2812B —»  3-pin

RGB LED x4 connector

LED x4
KEY x2
SWITCH x4

Figure 1-4 Board Block Diagram
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1.5 Getting Help

Here are the addresses where you can get help if you encounter any problem:
e Terasic Inc.
*9F., N0.176, Sec.2, Gongdao 5th Rd, East Dist, Hsinchu City, 30070. Taiwan
e Email: support@terasic.com
e Tel.: +886-3-5750-880

e \Web: http://T-Core.terasic.com
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Chapter 2
Using the T-Core

This chapter provides instructions to use the board and the peripherals description.

2.1 Configuration of MAX 10 FPGA on T-Core

There are two types of configuration method supported by T-Core:
1. JTAG configuration: configuration using JTAG port.

JTAG configuration scheme allows you to directly configure the device core through JTAG pins -
TDI, TDO, TMS, and TCK pins. The Quartus Prime software automatically generates .sof files that
are used for JTAG configuration with a download cable in the Quartus Prime software program.

2. Internal configuration: configuration using internal flash.

Before internal configuration, you need to program the configuration data into the configuration
flash memory (CFM) which provides non-volatile storage for the bit stream. The information is
retained within CFM even if the T-Core board is turned off. When the board is powered on, the
configuration data in the CFM is automatically loaded into the MAX 10 FPGA.

B JTAG Chain on T-Core Board

Figure 2-1 shows the JTAG interface of T-Core board, which uses the USB Blaster 11 (UB2) circuit
to connect to the host PC. The JTAG interface of the T-Core board can be divided into common
FPGA configuration and RISC-V applications. Users can configure or debug the MAX10 FPGA on
the T-Core through the UB2 interface and Quartus software on the host PC. You can also use the
UB2 circuit to download the binary file from the host PC to RISC-V application. The two position
switches on the SW2 can control whether the MAX10 FPGA and RISC-V application will appear in
the JTAG chain of the T-Core board.
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PC MAX10

—
USB uB2

— Connector —

i I MAX10 10 PIN
Open On-Chip Debugger <+—> (RISC.V JTAG PIN)
MAX10 JTAG Enable/Disable DIP x2 QSPI Flash
RISC-V JTAG Enable/Disable (RISC-V)

!

Figure 2-1 The JTAG configuration scheme

Figure 2-2 The JTAG Switch for MAX10 FPGA and RISC-V

Figure 2-2 shows the factory settings of the SW2. The SW2.1 position is used for enable/disable
the MAX 10 FPGA in the JTAG chain. When set to ON, the MAX10 FPGA will appear in the
JTAG chain of T-Core. SW2.2 is the JTAG chain switch for RISC-V applications. If it is turned off,
the application will not appear in the JTAG chain. For more information about the RISC-V
application, please refer to section 3.5 for more information.

Table 2-1 is the setting of SW2 and its function.

Table 2-1 MAX10 and RISC-V JTAG Chain setting for SW2

SW2 Position -
Description
[ MAX10 (SW2.1) RISC-V (SW2.2) |
OFF OFF

MAX10 and RISC-V off chain
OFF ON MAXZ10 off chain and RISC-V on chain
ON OFF MAX10 on chain and RISC-V off chain
ON ON MAX10 on chain and RISC-V on chain
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B Configure the FPGA in JTAG Mode

The following shows how the FPGA is programmed in JTAG mode step by step.

1. Open the Quartus Prime programmer, please choose Tools > Programmer. The Programmer
window opens. See Figure 2-3.

O3 Programmer - G/tmp/T-core/cd/Demonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau — O >

Eile Edit View Processing Tools Window Help

:..Hardware Setup... | | T-Core [USB-1] Mode:  JTAG s Progress:

[ Enabile real-time ISP to allow background programming when available

0 e File Device Checksum Usercode Program/  Werify = Blank- Examine
tart

Configure Check

M suto Detect
Delete

Y add File...

s Change File...

ol Save File
= Add Device...

i Down

Figure 2-3 Programmer Window

2.  Click “Hardware Setup”, as circled in Figure 2-3.

3. Ifitis not already turned on, turn on the USB-Blaster [USB-0] option under currently selected
hardware and click “Close” to close the window. See Figure 2-4.
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4.

4 Hardware Setup

Hardware Settings

JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware:

Available hardware items

T-Core [USB-1]

Hardware
T-Core

Server

Local

Port
USBE-1

| Add Hardware... |

Rermowve Hardware

Close

Figure 2-4 Hardware Setting
Click “Auto Detect” to detect all the devices on the JTAG chain, as circled in Figure 2-5.

i, Programmer - G:/tmp/T-core/cd/Demonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau..... - O s
File Edit View Processing Tools Window Help Search altera.com |.
; Hardware Setup... |T-Core [USE-1] Mode: | JTAG ~ Progress: ]
[ Enable real-time ISP to allow background programming when available
M ot File Device Checksum Usercode Program/  Verify  Blank- Examine
Configure Check
i Stop
B Auto Detect
Delete
™ add File...
TI]"ﬁ'ChangEFilE... < d
h cave File
P" Add Device...
A up
i Down
Figure 2-5 Detect FPGA device in JTAG mode
5. Select detected device associated with the board, as circled in Figure 2-6.
IC T-Core 10 www.terasic.com
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4 select Device ot

Found devices with shared JTAG ID for device 1. Please select your device.

@ 10Ms0DA

) 10Ms0DAES

) 10Ms0DC

Figure 2-6 Select 10M50DA device
6. FPGA s detected, as shown in Figure 2-7.

B Programmer - G./tmp/T-core/cd/Demanstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau.... — O >
File Edit WView Processing Tools Window Help Search altera.com |.
.?- Hardware Setup...| (T-Core [USBE-1] Mode: | JTAG g Progress: [ ]

[] Enable real-time ISP to allow backgreund programming when available
% Start File Device Checksumn Usercode Program/  Werify = Blank- Exarmnine
al
Configure Check
b stop <nones 10M50DA 00000000  <nones O O
M 2uto Detect
Delete
™ addFile..
ir Change File... < >
~
b save File
I* Add Device... N i
T = =
bop | || — E—
%Down ....------.
TOMS0DA
TDO
4
v
Figure 2-7 FPGA detected in Quartus Prime programmer
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7.

programmed, as highlighted in Figure 2-8.

Right click on the FPGA device and click “Change File” to open the .sof file to be

O3 Programmer - G:/tmp/T-core/cd/Demanstration/Default/T_CORE_Default - T_CORE_Default -

[T_CORE_Defau.....

*

8.
2-9.

[asic]

www.terasic.com

File Edit WView Processing Tools Window Help Lo com .
XK Delete Del
&, Hardware Setup..| |T-Core [USE-1] Mode: | JTAG Select All Ctrl+A
[] Enable real-time ISP to allow background programming when available U Add File.
I% Change File I
i . File Device Checks [0y cave Eile k- Examine
=1 =
ck
b stop <none> 10M50DA oooopog  AddIPSFile-. O
Change IPS File...
M Auto Detect _
Delete IPS File
—— Add EKP File..
Y add File.. Change EKP File...
Delete EKP File
= Change File... < z
Add PR Programming File... &
Hh save File
Change PR Programming File...
* add Device... e Delete PR Programming File
L] -
TODI E =
i Up R —— . : —_— Attach Flash Device...
0 ':: I Edit ’I Change Flash Device...
Down AR eE — i
10ME Show Device's Properties Delete Flash Device
TDO | -
4 Add Device...
v
Change Device
Replaces a selected programming file

Figure 2-8 Open the .sof file to be programmed into the FPGA device
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& select New Programming File >
Look in: G:\tmp\ T -core\cd\Demonstration\Default\output_files - 0 (5] 0 @ E]
W 1y Comp... || L] T_CORE_Default pof
[] T_coRrE_befault sof
3 user = =

File name: |T_CORE_Defau lt.sof

| | Open

Files of type: | Programming Files (*.sof *.pof * jam * jbc *.ekp * jic)

-

Cancel

Figure 2-9 Select the .sof file to be programmed into the FPGA device

9. Click “Program/Configure” check box and then click “Start” button to download the .sof file

into the FPGA device, as shown in Figure 2-10.

9 Programmer - G:/tmp/T-core/cd/Demaonstration/Default/T_CORE_Default - T_CORE_Default - [T_CORE_Defau..... - O X
File Edit WView Processing Tools Window Help Search altera.com ‘.
; Hardware Setup...| (T-Core [USBE-1] Mode: | JTAG g Progress: ’ ]

[] Enable real-time ISP to allow background programming when available
wh geart File Device Checksumn Usercode Program/ | Werify  Blank- Exarmnine
Configure Check
h stop output files/T CORE .. 10MS0DAF484 00410018  00410D18
M Auto Detect
X Delete
I add File...
= Change File... < z
~
B save File
* add Device... e
L] Ll
TOI =
N
u ol
L] -
I pown i. J.l.l.l.llJ.l.l._-:
TO0M50DAF484
TDO
4
v
Figure 2-10 Program .sof file into the FPGA device
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B Internal Configuration

e The configuration data to be written to CFM will be part of the programmer object file (.pof).
This configuration data is automatically loaded from the CFM into the MAX 10 devices when

the board is powered up.

ePlease refer to Chapter 4: Programming the Configuration Flash Memory (CFM) for the

basic programming instruction on the configuration flash memory (CFM).

MAX 10 Device
CRAM
Internal
JTAG 7f Configuration
In-System
Programmin
< S 5 RSy

Figure 2-11 High-Level Overview of Internal Configuration for MAX 10 Devices

B Status LED

The T-Core development board includes board-specific status LEDs to indicate board status. Please
refer to Table 2-2 for the description of the LED indicator. Please refer to Figure 2-12 for detailed

LED location.
LED7
e[ . 15 . )
Ai JPZJP;DT' vv

; _M-n___-=:::=~_=:==zzzr-0% z[® L E D6
- E' ; .l'Aﬁ_ LED5
g LED4

‘ ) i _"""‘_ - 4 v i LED [3:0] A

. ) e S M o

Figure 2-12 Status LED position
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Table 2-2 Status LED

Reference | LED Name Description

LED4 JTAG RX llluminate when data is transferred from USB Host to JTAG.
LED5 JTAG TX llluminate when data is transferred from JTAG to USB Host.
LED6 CONF_DONE llluminates when the FPGA is successfully configured.
LED7 Status llluminates Bard status

D3 5V llluminates when Input power is active. Not Installed.

D4 Power Good llluminates when board power system is OK.

2.2 Clock Circuitry

Figure 2-13 shows the default frequency of all external clocks to the MAX 10 FPGA. A clock
generator is used to distribute clock signals with low jitter. The two 50MHz clock signals connected
to the FPGA are used as clock sources for user logic. One 24MHz clock signal is connected to the
clock inputs of USB microcontroller of USB Blaster. One 10MHz clock signal is connected to the
PLL1 and PLL3 of FPGA, the outputs of these two PLLs can drive ADC clock. The associated pin
assignment for clock inputs to FPGA I/O pins is listed in Table 2-3.

Warning!!
Do not modify the clock generator settings.

Incorrect setting will cause the system to not work.

Clock Generator
Si51211

24MHz
. ADC_CLK_10

MAX10_CLK1_50
MAX10_CLK2_50

A .
>

>» P11
> N14

Figure 2-13 Clock circuit of the FPGA Board

Table 2-3 Pin Assignment of Clock Inputs

ADC_CLK_10 PIN_N5 10 MHz clock input for ADC (Bank 3B) 3.3-V LVTTL

MAX10_CLK1 50 |PIN_P11 50 MHz clock input(Bank 3B) 3.3-V LVTTL

MAX10_CLK2 50 | PIN_N14 50 MHz clock input(Bank 3B) 3.3-V LVTTL
T-Core 15 www.terasic.com
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2.3 Using the Push-buttons, Switches and LEDs

B User-Defined Push-buttons

The board includes two user defined push-buttons that allow users to interact with the MAX 10
FPGA device. Each of these switches is debounced using a Schmitt Trigger circuit as indicated in
Figure 2-14. A Schmitt trigger feature introduces hysteresis to the input signal for improved noise
immunity, especially for signal with slow edge rate and act as switch debounce in Figure 2-15 for
the push-buttons connected. Table 2-4 list the pin assignment of user push-buttons.

KEYO0

VCC3P3

L (inteD)

KEY1 SN74LVC2G17
- :
O— - mo CMAX 10
FPGA
L i e

Figure 2-14 Connections between the push-button and MAX 10 FPGA

Before

lPushbutton depressed

lPushbutton released

Debouncing ||||||||| |||||||

Schmitt Trigger

Debounced

KEYI[O] PIN_AB9

A\ 4

&
<

Figure 2-15

Switch debouncing

~ Table2-4 Pin Assignment of Push-buttons

Slgnal Name FPGA Pin No. I/O Standard ‘

Push-button[0]

3.3V SCHMITT TRIGGER"

KEY[1] PIN_AA9

Push-button[1]

3.3V SCHMITT TRIGGER"

B User-Defined Dip

Switch

There are 4 position dip switches connected to FPGA on the board (See Figure 2-16). These
switches are used as level-sensitive data inputs to a circuit. Every one of the switches is connected
directly and individually to a pin on the MAX 10 FPGA. When the switch is in the ON position

T-Core
asiC User Manual
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(closest to the edge of the board), it provides a low logic level to the FPGA, and when the switch is
in another position, it provides a high logic level. Table 2-5 list the pin assignments of the user

switches.

<max 10

AB16 Y16 V16  AB17

Logic"0”

Logic"1”

Figure 2-16 Connections between the slide switches and MAX 10 FPGA
Table 2-5 Pin Assignment of Slide Switches

Signal Name FPGA Pin No. |Description I/0 Standard

SWI0] PIN_AB16 Dip Switch[0] 3.3-V LVTTL
SWI[1] PIN_Y16 Dip Switch[1] 3.3-V LVTTL
SW[2] PIN_V16 Dip Switch[2] 3.3-V LVTTL
SWI[3] PIN_AB17 Dip Switch[3] 3.3-V LVTTL

B User-Defined LEDs

There are also four user-controllable LEDs connected to FPGA on the board. Each LED is driven
directly and individually by a pin on the MAX 10 FPGA; driving its associated pin to a high logic
level turns the LED on, and driving the pin low turns it off. Figure 2-17 is the connections between
LEDs and MAX 10 FPGA. Table 2-6 list the pin assignment of user LEDs.
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AA16 LEDGO . A _LEDGO bIZLZ\
AB15 LEDG1 A~ A LEDG1 DIZ!Z\

F : AA15 LEDG2 LEDG2
<max 10 RS ARG Y7
FPGA

AA14 LEDG3 LEDG3

Figure 2-17 Connections between the LEDs and MAX 10 FPGA

Table 2-6 Pin Assignment of LEDs

LED[0] PIN_AA16 LED [0] 3.3-V LVTTL
LED[1] PIN_AB15 LED [1] 3.3-V LVTTL
LED[2] PIN_AA15 LED [2] 3.3-V LVTTL
LED[3] PIN_AA14 LED [3] 3.3-V LVTTL

2.4 Using WS2812B RGB LED

The board has Built-in the four Color LED (WS2812B) with intelligent controller (See Figure 2-18)
and the four LED are connected in series controlled by one GPIO line. The WS2812B is an
intelligent control LED light source that the control circuit and RGB chip are integrated in a
package of 5050 components. It internal includes intelligent digital port data latch and signal
reshaping amplification drive circuit. Also includes a precision internal oscillator and a 12V voltage

programmable constant current control part, effectively ensuring the pixel point light color height
consistent.

WS2812B WS2812B WS2812B WS2812B 5V p3
DI DO DI DO DI DO DI DO L
-
u14

Level Shift

<max 10
D1 9 OB_LED_RGB_D

—_—>

EX_LED_RGB_D
B >

OB_LED RGB_DIN |3V JP4

y

EX_LED RGB_DIN ‘.
>
_

Figure 2-18 Level Shift between the REG LEDs and MAX 10 FPGA
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B Control Method

For the WS281B RGB LED, each R/G/B color can be independently controlled, and each color can
be adjusted from level O to 255. Therefore, each color needs to use 8bit control, and each LED

needs 24bit control. The 24 bits corresponds to the Figure 2-19.

Composition of 24bit data:

G7

G6

G5

G4

G3

G2

G1

GO

R7

R6

RS

R4

R3

R2

R1

RO

B7

Bé

B5

B4

B3

B2

B1

BO

Note: Follow the order of GRB to sent data and the high bit sent at first.
Figure 2-19 Composition of 24bit data

The logic 1 or 0 of each bit is determined as shown in Figure 2-20. It is determined by the length of
the voltage level in a period. Detailed specifications can refer to Table 2-7.

RET code

0 code

1 code

Figure 2-20 Sequence Chart

A —
TOH

TOL

M

TIL

<

TIH

Treset

Table 2-7 Code Timing

TOH 0 code, high voltage time 220ns~380ns
T1H 1 code, high voltage time 580ns~1ps
TOL 0 code, low voltage time 580ns~1ps
TiL 1 code, low voltage time 220ns~420ns
RES Frame unit, low voltage time >280us

The data transfer protocol of the WS281 use single NRZ communication mode. As shown in Figure
2-21, after the pixel power-on reset, the DI port receive data from controller, the first pixel collect
initial 24bit data then sent to the internal data latch, the other data which reshaping by the internal
signal reshaping amplification circuit sent to the next cascade pixel through the DO port. After
transmission for each pixel, the signal to reduce 24bit. Pixel adopt auto reshaping transmit
technology, making the pixel cascade number is not limited the signal transmission, only depends
on the speed of signal transmission.
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Cascade method:

D1 D2 D3 D4
—{DIN DO DIN DO DIN DO
PIX1 PIX1 P1X1
Data transmission method:
—s| reset code |« reset
>=50us code
< Data refresh cycle 1 Data refresh cycle 2 ——
first [second| third first [second| third
D1 24bit | 24bit | 24bit 24bit | 24bit | 24bit
second| third second| third
24bit | 24bit 24bit | 24bit
D2
third third
D3 24bit 24bit
D4

Figure 2-21 Data Transmission Method

The DIN signal level of the WS2812B is 5V, so a Level Shift will be required to raise the control
signal voltage to the 5V level. Table 2-8 shows the pin assignment of RGB LED Control signal.

More information about the RGB Color LED is available in its datasheet. It can be found on

manufacturer’s website or in the directory \Datasheet\RGB_LED of system CD.

Table 2-8 Pin Assignment for RGB Color LED and Extension port

Signal Name

OB_LED_RGB_D

PIN_D19

On-Board RGB LED Data IN

3.3-V LVTTL

EX_LED_RGB_D

PIN_D18

RGB LED Data IN for External Header

3.3-V LVTTL

B Expansion Port

In addition to the Built-in four RGB LEDs on the T-Core board, two 3-pin headers (JP3 and JP4)
are reserved for user to expand more LED. Users can purchase the commercially RGB LED Line
Pipe in series to make the application more widely available.

See Figure 2-22, if user expands more RGB LEDs on JP3, it must be noted that the control method
should take into account that there are four on board LEDs on the front end. If you use JP4 to
expand and connect more LEDs, you only need to consider the newly added LEDs for the

controlling.

For these 3 pins header, detailed information is described as follows:
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Pin 1 of the 3-pin header is a 5V power supply, but may not provide sufficient current for the
extended LED strip (when connected a lot). Therefore, if the user needs to connect more than one
LED strip, please do not connect the pin.1 of the 3-pin header, please supply it to the LED strip by

an external 5V power supply.

Pin 2 of the header is a serial control signal with a voltage level of 5V. The user can define an

arbitrary waveform to output.

Pin 3 is grounded. Please note that if the external light strip is attached, the ground of the light strip

should be connected to this pin.

For detailed RGB LED and JP3/JP4 position, please refer to
method, refer to Figure 2-23.

————pin.1

/ g&%
/ // [~ pin1
/ / pin.2

/ / pin.3

*us = 3 !

ooooogo!

Figure 2-22, simple connection

VCC5
OB_LED_RGB_DOUT
GND

VCC5
EX_LED_RGB_DIN
GND

-RGB_LEDO

i

RGB_LED3

GND/5V

Power Supply 5V

Figure 2-23 An example of a color light bar connection for an external power supply

2.5 Using 2x6 TMD GPIO Expansion Headers

The board has one 2x6 TMD (Terasic Mini Digital) expansion header. The TMD header has 8
digital GP1O user pins connected to the MAX 10 FPGA, two 3.3V power pins and two ground pins.
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There are two Transient Voltage Suppressor diode arrays used to implement ESD protection for 8
GPIO user pins.

Figure 2-24 shows the connection between the TMD header and MAX 10 FPGA. Table 2-9 shows
the pin assignment of 2x6 TMD header.

VCC3P3

%

intel)

<max 10

TMD_DJ[7..0]

Figure 2-24 Connections between the 2x6 TMD header and MAX 10 FPGA
Table 2-9 Pin Assignment of 2x6 TMD Header.

TMD_DI[0] PIN_ABS8 GPIO Connection [0] 3.3-V LVTTL
TMD_DI1] PIN_AAS8 GPIO Connection [1] 3.3-V LVTTL
TMD_DI[2] PIN_AA5 GPIO Connection [2] 3.3-V LVTTL
TMD_DI3] PIN_AB5 GPIO Connection [3] 3.3-V LVTTL
TMD_DI[4] PIN_AB7 GPIO Connection [4] 3.3-V LVTTL
TMD_DI5] PIN_AA7 GPIO Connection [5] 3.3-V LVTTL
TMD_DI6] PIN_ABG6 GPIO Connection [6] 3.3-V LVTTL
TMD_DJ[7] PIN_AA6 GPIO Connection [7] 3.3-V LVTTL

2.6 1x10 A/D Converter and Analog Input

The board has eight analog inputs are connected to MAX 10 FPGA ADC1, through a 1x10 header
(JP1) input. Any analog inputs signals sourced through the header JP1 are RC filtered by the Analog
Front-End circuit, and the maximum allowable input voltage 2.5V per the MAX 10 FPGA ADC IP
block. Figure 2-25 shows the connections between the header input and FPGA.
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ADC_IN[8..0]

ADC_IN[7..0]

JP1
ADC_INO
ADC_IN1
ADC_IN2
ADC_IN3
ADC_IN4
ADC_INS
ADC_IN6
ADC_IN7

GND

Figure 2-25 Connections between the Arduino Analog input and MAX 10 FPGA

Table 2-10 shows the pin assignment of 1x10 Analog input header.

Table 2-10 Pin Assignment of Analog Input

ADC_IN [0] PIN.F5 B Analog Input Data[0] 2.5-VLVTTL
ADC_IN [1] PIN_F4 Analog Input Data[1] 2.5-VLVTTL
ADC_IN [2] PIN_J8 Analog Input Data[2] 2.5-VLVTTL
ADC_IN [3] PIN_J9 Analog Input Data[3] 2.5-VLVTTL
ADC_IN [4] PIN_J4 Analog Input Data[4] 2.5-VLVTTL
ADC_IN [5] PIN_H3 Analog Input Data[5] 2.5-VLVTTL
ADC_IN [6] PIN_K5 Analog Input Data[6] 2.5-VLVTTL
ADC_IN [7] PIN_K6 Analog Input Data[7] 2.5-VLVTTL

2.7 Using QSPI Flash

The board supports a 64M-bit serial NOR flash device for non-volatile storage, user data and
program. This device has a 4-bit data interface and uses 3.3V CMOS signaling standard.
Connections between MAX 10 FPGA and Flash are shown in Figure 2-26. Table 2-11 shows the

QSPI Flash pin assignments
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u20

«OSPLFLASH DATAS) o f 1161 p#iDQ3
< QSPI_FLASH DATA[2] »| WP#DQ2
fntel ) < QSPI_FLASH_DATA[1] »| so/pQ1
((,_ < QSPI_FLASH_DATA[0] »| SI/DQO
max: 10 QSPI_FLASH_SCLK »| SCLK
QSPI FLASH_CEN | CE#
FLASH

Figure 2-26 Connections between MAX 10 FPGA and QSPI Flash

Table 2-11 Pin Assignment of QSPI Flash

Signal Name 'FPGA Pin No. /0 Standard

QSPI_FLASH_DATA[O] | PIN_P21 FLASH Data|0] 3.3-V LVTTL
QSPI_FLASH_DATA[1] | PIN_P18 FLASH Data[1] 3.3-V LVTTL
QSPI_FLASH_DATA[2] | PIN_R18 FLASH Data[2] 3.3-V LVTTL
QSPI_FLASH_DATA[3] | PIN_P20 FLASH Data[3] 3.3-V LVTTL
QSPI_FLASH_SCLK PIN_P19 FLASH Data Clock 3.3-V LVTTL
QSPI_FLASH_CEN PIN_L22 FLASH Chip Enable 3.3-V LVTTL
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Chapter 3

Example Designs

This chapter provides examples of advanced designs implemented by RTL or Qsys on the T-Core
board. These reference designs cover the features of peripherals connected to the FPGA, such as
RGB LED. All the associated files can be found in the directory \Demonstrations of T-Core System
CD.

B Installation of Demonstrations
To install the demonstrations on your computer:

Copy the folder Demonstrations to a local directory of your choice. It is important to make sure the
path to your local directory contains NO space. Otherwise, it will lead to error in Nios Il software.

Note: Quartus Prime Standard v18.1 or later is required for all T-Core demonstrations to support
MAX 10 FPGA device.

3.1 T-Core Factory Configuration

The T-Core board has a default configuration bit-stream pre-programmed, which demonstrates some
of the basic features onboard. The setup required for this demonstration and the location of its files
are shown as below.

B System Block Diagram

Figure 3-1 shows the system block diagram of this demonstration. This system can control the four
on-board green LEDs to all light on or blink. It can also control the four on-board RGB LEDs to
display the Red/Green/Blue/White colors, or the 0~360degree continuous color according to the
Hue of the HSL Color Model.
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MAX 10

,\,)ﬂ. PLL100 o

50Mhz ' 1
- ram_data[23:0] ' Read Bus
m_, | TWO_PORT_RAM L=
7 COLOR_ ram_wraddress[n-1 :0] DOUT EX_LED_RGB_DIN &
Color_selection Brocoster . ‘ ILED_CONTROLLER [SEsEat OB_LED_RGB_DIN
COLOR[23:0] update_reqeust —'s
_’ -
update_done
A — —
LED_flicker e
50Mhz
—b

v
LED 0~3 KEY1

5 ram_wrclock

Figure 3-1 Block diagram of the Default demo
Below is the description for the block diagram:
1. PLL100: PLL module. Input 50MHz clock and output 100MHz clock.
2. KEY1: Itis used to reset the system.

3. Color_selection: Provides four fixed colors Red/Green/Blue/White or the 0~360 degree
continuous color according to the Hue of the HSL Color Model. When the KEYO is pressed, the
color of the four on-board RGB LEDs is depending on the SW[1:0] setting, they will display
Red/Green/Blue/White color respectively when the SW[1:0] is set as 00/01/10/11. If the KEYO
is not pressed, the four RGB LEDs will display 0~360 degree continuous color.

4. LED_flicker: It controls the four on-board green LEDs to all light on or blink with 1Hz
frequency. The four LEDs will all light on when KEYO is pressed, or will blink with 1Hz if the
KEYO is not pressed.

5. WS2812: It is the WS2812 IC control IP, it can control any WS2812 IC, it contains two main
parts:

TWO_PORT_RAM: User can write in the R[7:0] G[7:0] B[7:0] data to control any one of RGB
LEDs to be light as any colors. For example, user can set ram_wraddress=2, ram_data = {R[7:0],
G[7:0], B[7:0]} = {8h00,8’hff ,8°’h00} to make the RGB LED3 light as Green, then set the
ram_wrclock to 0->1->0, the data will be written to the RAM.

ILED CONTROLLER: After the LED RGB data is written successfully, active the
update request as “1” to inform the ILED CONTROLLER read out the RGB data in sequence
through the TWO_PORT_RAM, and input to the corresponding LED. The update_request must
return to “0” after a short of delay (>0.02MHz). The DOUT is the bit string data, the “07/“1”
Sequence chart of each bit is generated according to WS2812 datasheet page 4. The sequence chart
of each RGB bit is generated according to WS2812 datasheet page 5. After all the data is transferred
to WS2812 RGB LED, this module will return update done =1 to indicates the data transmission
is completed.
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6. COLOR_Processer: It will extract the color date from Coloe_selection according to WS2812
IP controlling request, then output to the TWO_PORT_RAM in WS2812 IP, when this is
completed, it will inform the ILED_CONTROLLER in WS2812 IP to sequence read out the
RGB data stored in TWO_PORT_RAM, then the ILED_CONTROLLER will transfer the RGB
data to each WS2812 IC and wait for update done = “1” returned by ILED CONTROLLER, it
indicates the process is completed.

B Demonstration File Locations

e Project directory: \Default
e Bitstream used: T_CORE_Default.sof, T_CORE_Default.pof
B Demonstration Setup and Instructions
e Connect the Mini USB connector (J2) of the T-Core board to the host PC with a USB cable and
install the USB-Blaster Il driver if necessary.
e Execute the demo batch file “test.bat” from the directory \Default\demo_batch\

o |f the KEYO is not pressed, the four on-board green LEDs will blink in 1Hz and the four
on-board RGB LEDs will display 0~360 degree continuous color according to the Hue of the
HSL Color Model.

e |f the KEYO is pressed on (do not release), the four on-board green LEDs will all light on, the
color of the on-board four RGB LEDs is depending on SWI[1:0], they will display
Red/Green/Blue/White color respectively when the SW[1:0] is set as 00/01/10/11.

e Figure 3-2 shows the color of the four on-board green LEDs and RGB LEDs display.

RGB LED

|[@[o][= s s+ = ~z(@
P2 4p3 2

. e

S ————————
C ¥

semw.

I8!
s O
>

0 e e se

Green LED

Figure 3-2 On-Board Green LED and RGB LED display
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B Restore Factory Configuration

e Connect the mini USB connector (J2) of the T-Core board to the host PC with a USB cable and
install the USB-Blaster 1l driver if necessary.

¢ Execute the demo batch file “program.bat” from the directory \Default\demo_batch\

e After the program is executed successfully, the program message as shown in Figure 3-3.
Please press any key to continue and the window will be closed.

B CA\WINDOWS\system32\cmd.exe

Figure 3-3 Quartus Prime Program MAX 10 CFM message

3.2 Control RGB LED in Nios 1l

Based on this demonstration, user can quickly learn how to develop C language program to control
the RGB LED:s, it provides corresponding API function and allows the user to quickly started.

B System Block Diagram

Figure 3-4 shows the system block diagram of this demonstration. Nios Il CPU and WS2812
Controller must run in 100MHz, the on-board OSC 50MHz needs to be multiplied to 100MHz
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through the PLL, the JTAG is used to print information, the Nios Il required a system time, the C
language program is stored in On-Chip memory, user can develop C program to call the API
WS2812 Controller, then control the RGB LEDs. User can also control the external RGB LED by
modifying the parameters in the C program.

FPGA

&) asvs
50 MHz ,
£~

JTAG T

-

Figure 3-4 Block diagram of the SDRAM test in Nios Il

" On-Chip

!

Memory

EX_LED_RGB_D
| i
o WS2812

Controller g OB_LED_RGB_D

P

1

System Intercoment Fabric

B Design Tools

e Quartus Prime v18.1
e Nios Il Eclipse v18.1

B Demonstration Source Code

e Quartus project directory: \RGBLED_NIOS
e Nios Il Eclipse directory: \RGBLED_NIOS\Software
B Nios Il Project Compilation

¢Click “Clean” from the “Project” menu of Nios Il Eclipse before compiling the reference
design in the Nios Il Eclipse.

B Demonstration Batch File

e The files are located in the director: \RGBLED_ NIOS\demo_batch

¢ The folder includes the following files:
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e Batch file for USB-Blaster II: test.bat and test.sh
e FPGA configuration file: T_CORE.sof
e Nios Il program: WS2812_Test.elf

B Demonstration Setup

e Quartus Prime v18.1 and Nios Il v18.1 must be pre-installed on the host PC.

e Connect the T-Core board to the host PC with a USB cable and install the USB-Blaster driver if
necessary.

e Execute the demo batch file “test.bat” from the directory \REGLED_NIOS\demo_batch

e After the program is downloaded and executed successfully, a prompt message will be
displayed in nios2-terminal.

eThe program will display the test progress and result, as shown in

B8 Altera Nios Il EDS 18.1 [geed]

Figure 3-5.

eAs shown in Figure 3-6, the RGB LED[3:0] display purple/green/orange/red and
red/orange/green/purple respectively in turns.
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Figure 3-6 The RGB LEDs display after executing the batch file

3.3 Control External RGB LED in Nios 1l

This demonstration is very similar to the one in section 3.2. The difference is that user need to
connect external RGB LEDs. Without the external power, the T-Core can control almost 10~20
external RGB LEDs, the quantities of external RGB LEDs are depending on the user’s code which
is used to control the LED lightness.

User can refer to below demonstration to modify the C program and control the external RGB
LEDs.

#define LED_NUM 143 // modify LED number

/[call function WS2812 LED_SET(alt_u32 SelLED,alt_u8 R_Color, alt_u8 G_Color, alt_u8 B_Color)

/ISelLED: Select LED ,Red:8Bit ,Green: 8Bit ,Blue: 8Bit

WS2812_LED_SET(100,30,0,0); // set number 100 LED to red color.

WS2812_update();//update status

B Design Tools

e Quartus Prime v18.1
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eNios Il Eclipse v18.1
B Demonstration Source Code

e Quartus project directory: \RGBLED_ NIOS_EXT
e Nios Il Eclipse directory: \ RGBLED _NIOS_EXT\software

B Demonstration Batch File

e The files are located in the director: \ RGBLED_ NIOS_EXT\demo_batch
¢ The folder includes the following files:

e Batch file for USB-Blaster: test.bat and test.sh

¢ FPGA configuration file: T_CORE.sof

e Nios Il program: WS2812_ Test.elf

B Demonstration Setup

e Quartus Prime v18.1 and Nios Il v18.1 must be pre-installed on the host PC.

¢ As shown in Figure 3-7, connect the external RGB LED strip to the JP3 or JP4 port of T-Core
board, the pin marked with red box is connected to VCC, the pin marked with green box is
connected to the signal, the pin marked with yellow box is connected to GND.

e Connect the T-Core board to the host PC with a USB cable and install the USB-Blaster driver if
necessary.

e Execute the demo batch file “test.bat” from the directory \RGBLED _ NIOS_EXT\demo_batch

e After the program is downloaded and executed successfully, a prompt message will be
displayed in nios2-terminal.

e The color of external RGB LED strip will change in turn.
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Figure 3-7 External RGB LED connection diagram

3.4 ADC Measurement

This demonstration shows how to use the FPGA on-die ADC to measure the input power voltage
from the eight analog input pins among the ADC connector. The measured voltage is displayed on
the Signal Tap. Figure 3-8 shows the block diagram of this demonstration. The main control uses
the Intel ADC IP to retrieve the 12-bit digitalized analog value according the channel specified by
the SWITCH on the T-Core board. The input voltage can be calculated based on the 12-bit digital
value. Finally, the voltage value will be displayed on the Signal Tap Logic Analyzer.

The 12-bit represents 0~2.5V input voltage to the ADC hardware. The input voltage to the ADC
analog input can be calculated with the formula listed below:
Voltage input= (12-bit integer value)/4096 x 2.5
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Figure 3-8 Block diagram of the ADC measurement demonstration

Table 3-1 The SW[2:0] Setting

SW(2:0) ADC_Source

3°b000 ADC_INO
3°b001 ADC_IN1
3°b010 ADC IN2
3°b011 ADC IN3
3°b100 ADC_IN4
3’b101 ADC_IN5
3°b110 ADC_ING6
3’bl11 ADC_IN7

In the demonstration, a Signal Tap is provided to display the retrieved 12-bit digitalized value and
the calculated voltage for the input power to the analog input as shown in Figure 3-9.

F-cur_adc_ch[4..0] : o1h
response_valid " " "_
*-adc_sample data[11..0] E|: 3931 | 3933 |
- vol_mv[11..0] i 2300 | 2400 |

Figure 3-9 Signal Tap of ADC

B Design Tools
e Quartus Prime 18.1 Standard Edition
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B Demonstration Source Code

e Quartus Project directory: ADC_RTL
e Bitstream used: T_CORE.sof
e Demo Batch File: ADC_RTL\demo_batch\test.bat

B Demonstration Setup

e Make sure Quartus Prime is installed on your PC

e Connect analog source to the analog input as shown in Figure 3-10.

Variable Voltage 0~2.5V
Ch1 Variable Vo*ltage Circuit

O opREst
3.3V DC GND
Power

Figure 3-10 Connect analog source to the analog input

e Use the USB Cable to connect your PC and the FPGA board and install USB Blaster Il driver if
necessary.

e Execute the demo batch file “test.bat” from the directory ADC_RTL\demo_batch.
e Use SWJ[2:0] to specify measured analog input channel.

¢ The measured channel and voltage will be displayed on Signal Tap Logic Analyzer as shown in
Figure 3-11.

In the above steps we use a self-made variable voltage output circuit. It uses the T-Core 3.3V as the
power source, the output voltage is adjusted by the divider resistance and the variable resistor of the
circuit, which can convert the T-Core 3.3V to a 0~2.5V analog input (to the ADC_INO channel).
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Note: Users can input their own power source, please make sure the input voltage is 0~2.5V,
otherwise there is a risk of damage to the development board.

7= Quartus Prime Signal Tap Loge Analyzer Standard Edtion - [ade ol R —— s et e
Ehe Lot Yew Proomang  Joos  pelp ©
= ) Q"
ratance Masager A B B 50 feady 10 scquire X | SFTAG Chain Configunation, JTAG ready *
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2] auto_vgnaltap 0 Not svnrung / 839 colls 61450 bits NA ra NA
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Figure 3-11 Signal Tap Logic Analyzer displays the measured channel and voltage
3.5 RISC-V

B RISC-V Brief Introduction

RISC-V is a free and open Instruction Set Architecture (ISA) enabling a new era of processor
innovation through open standard collaboration. Any organization or individual can design their
own processor based on the RISC-V architecture. Freedom E300, a RISC-V core implemented in
RTL, is realized on T-Core FPGA Board. For more information about Freedom E300, user can learn
more from web (https://github.com/sifive/freedom).

Figure 3-12 shows the top-level block diagram of the Freedom E300 which contains an E31
Coreplex, a selection of flexible 1/0 peripherals, a dedicated off-chip Quad-SPI flash controller with
execute-in-place support, On-chip Memory, clock generation, and an always-on (AON) block. In
addition, custom accelerator can be added to provide application-specific processing.
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Figure 3-12 Top-Level Block Diagram of the E300 platform

The memory map of Freedom E300 is shown in Table 3-2.

Base

0x0000_0000
0x1000_0000
0x1000_8000

0x1001_0000
0x1001_1000
0x1001_2000
0x1001_3000
0x1001_4000
0x1001_5000
0x1002_3000
0x1002_4000
0x1002_5000
0x1003_4000
0x1003_5000
0x2000_0000
0x4000_0000

0x8000_0000
0x8002_0000

[asic]
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Table 3-2 Memory map of Freedom E300

To p
OXOFFF_FFF
0x1000_7FFF
0x1000_FFFF

Description

refer E3 Coreplex Manual
Always-On (AON)
Power, Reset, Clock,
(PRCI)

On-chip OTP control
On-chip eFlash control

0x1001_OFFF
0x1001_1FFF

0x1001_2FFF GPIO0
0x1001_3FFF UARTO
0x1001_4FFF QSPIO
0x1001_5FFF PWMO
0x1002_3FFF UART1
0x1002_4FFF QSPI1
0x1002_5FFF PWM1
0x1003_4FFF QSPI2
0x1003_5FFF PWM?2
Ox3FFF_FFFF QSPI0 XIP

OX7FFF_FFFF Additional 1/0 or RAM

Instruction and Data RAM
Additional RAM

0x8001_FFFF
OXFFFF_FFFF

T-Core
User Manual

38

Notes

E3 Coreplex

Interrupt

On-Chip Peripherals

Off-Chip

Non-\olatile

Memory
On-Chip
Memory

\olatile

www.terasic.com
January 14, 2020


http://www.terasic.com/
http://www.terasic.com/
http://www.terasic.com/

B About Quartus Project

The original Freedom E300 was implemented in the Scala and is not suitable for the T-Core FPGA
board. We modified the Scala source code so that it can run on T-Core. Since the Verilog code
generated by the Scala is hardly readable, we encapsulate it. Place the clock, reset, JTAG interface,
QSPI interface, GPIO interface (including various peripherals such as UART, 12C, SPI, etc.) on the
top-level port for easy logic operation and pin connection to the FPGA. The interface of the top file
is as follows.

149 EFreedom_E300 wrapper E300_SoC_wrapped(

150 /¥input wire .clock (clk_32m),

151 /¥input wire % / .aon_lfextclk (slowclk),

152

153 /*input wire */ .aon_erst_n (~ip_reset_sys_peripheral_reset),
154 /¥*input wire ¥, . jtag_reset (fpga_power_on_power_on_reset),
155 /¥output wire */ .1o_ndreset (ip_reset_sys_m debug_sys_rst),
156

157 /¥input wire ¥/ .jtag_tck (RISCV_JITAG_TCK),

158 /¥input wire %/ . Jjtag_tms (RISCV_JITAG_TMS),

159 /*input wire %/ . jtag_tdi (RISCV_JITAG_TDI),

160 /¥output wire */ .Jjtag_tdo (RISCV_JITAG_TDO),

161

162 /¥output wire */ .gspi_sck (QSPI_FLASH_SCLK),

163 /¥output wire */ -gspi_cs_0 (QSPI_FLASH_CE_n),

164 /*inout wire [3:0] %/ .gspi_dqg (QSPI_FLASH_DATA),

165

166 /*input wire [31:0] =/ .e300_gpio_i_ival (e300_gpio_i_ival),

167 /*output wire [31:0] */ .e300 gp1o o_ie (e300_ gp1o o_ie),

168 /¥output wire [31:0] */ .e300_gpio_o_oval (e300_gpio_o_oval),

169 /*output wire [31:0] */ .e300_gpio_o_oe (e300_gpio_o_oe)

170

171 )

Add the PLL, Clock, LED and control logic to the Freedom E300 Wrapper to generate the
complete Quartus Project. The block diagram is shown below. The completed Quartus project is
detailed in the demonstration directory.
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T-Core

FPGA

E300 Platform
(Freedom_E300_Wrapper)

eFlash
EEPROM
Quad SPI Flash - QSPI Flash

GPIO Complex
PWM
UART
QSPI

E31
Coerplex

P-Bus: TileLink B32 D32

Clock Generation

Always-On Block
Power Management
Backup Registers
Custom Always-On
Real-Time Clock
Watchdog Timer
Reset Unit

Figure 3-13 Quartus Project System Block
B How to Run Demo (Using Ubuntu)

4 Host PC

A Linux system is required to compile the RISC-V C-code project and download the binary file to
the T-Core QSPI Flash. In the following demo, Ubuntu 16.04 is used and recommended. Quartus
Prime (or Quartus Programmer), USB Blaster Il Driver, RISC-V BSP should be installed on the
host PC before running the demo.

€ Intel Quartus Prime

Intel Quartus Prime 18.1 Standard Edition can be download from web site:
http://fpgasoftware.intel.com/18.1/?edition=standard&platform=linux&download _manager=dIima3.

For Quartus Prime installation, please make sure the MAX 10 device is included.
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Quartus Prime Standard Edition
Release date: September, 2018
Latest Release: v18.1

Select edition:

Intel’ Quartus’ Prime

Design Software

Select release:

Operating System @ O/’ windows © /;\ Linux

Download Method @ ®Akamai DLM3 Download Manager @@ ODirect Download

+ The Quartus Prime Design Software Standard Edition v18.1 Update 1 has been updated with Curl 7.64.0, CygWin
3.0.3, expat 2.2.6, flexnet_publisher 11.16.2.1, glib 2.56.1, gstreamer 1.14.0, guava 27.0.1, jre (Oracle Java) 1.8.0u202,
libicu 61.0, libpng 1.6.36, openssl 1.0.2r, perl 5.28.1, python 3.6.8, qt 5.11.3, ccl_sqlite3 3.26.0, sqlite3 (python) 3.26.0,
sqlite3 (qt) 3.27.2, xerces-c++ 3.2.2, and zlib 1.2.11, which include functional and security updates. Users should update
to the latest version of Quartus Prime design software as soon as possible.

+/ The Quartus Prime Standard software version 18.71 supports the following device families: Stratix IV, Stratix V, Arria Il
Arria V, Arria V GZ, Arria 10, Cyclone 10 LP, Cyclone IV, Cyclone V, MAX II, MAX V, and MAX 10 FPGA. More

!
Combined Files Individual Files Additional Software

Download and install instructions: More
Read Intel FPGA Software v18.1 Installation FA
uick Start Guide

M select All O

M Quartus Prime Standard Edition
GQuartus Prime (includes Nios Il EDS))
Size: 2.7 GB MD5: 7D26DB3BBOEDS8EAB62D30FDA4EE316B1
ModelSim-Intel FPGA Edition (includes Starter Edition)

Size: 1.1 GB MD5: 4628A15C65D37A6079D3BE2DFCBD9993
** Require 32-bit libraries, see  installation manual

Updates Available

MDevices
You must install device support for at least one device family to use the Quartus Prime softwart

Arria Il device support
Size: 669.7 MB MD5: 3F397B96CCD63E70205391B92BE5AC62

Arria 10 device support i ]

Arria 10 device support Part 1

Size: 3.2 GB MD5: EATE93E1C56DBEEA925EBE68E2BA2837
Arria 10 device support Part 2

Size: 2.5 GB MD5: 907CBB967E5FOBE384CB74FD458CD639
Arria 10 device support Part 3

Size: 4.3 GB MD5: F22EEDCA1CB53493BC297ED9C3A15760

Arria V device support

Size: 1.3 GB MD5: 3E8B6C4389F8E02D666D97B13F2D6512

Arria V GZ device support

Size: 2.0 GB MD5: 8AAC6C7CC794D76B4E79738C33DEDD12

Cyclone IV device support

Size: 466.6 MB MD5: 9E32B85F83A440604154BD729B143D5C

Cyclone 10 LP device support

Size: 266.1 MB MD5: 72AAE619D358FF6B8E42849B3BFCFADD

Cyclone V device support

Size: 1.1 GB MD5: 75F5029A9058F64F969496B016EET19D4

MAX Il, MAX V device support

Size: 11.4 MB MD5: ED990775F76C35D308877F27A30B7555
vIMAX 10 FPGA device support

Size: 330.9 MB MD5: EB7E56DAB1A4529EFC515C2452F1BTFE

Stratix IV device support

Size: 544.5 MB MD5: 42E15BESFDDC5TAF6E87F9884A5ADTDD

Stratix V device support
Size: 2.9 GB MD5: 29FCFF7451418B5EAA6044548E5C7C93

ownload Selected Files [ NINENSTINTTNI.

Note: The Quartus Prime software is a full-featured EDA product. Depending on your download speed,
download times may be lengthy.

Figure 3-14 Download Quartus Prime 18.1 Standard Edition

€ USB-Blaster Il Driver

The Intel Quartus Prime software accesses USB-Blaster Il through USB file system. After installing
the Quartus Prime software, user need to change the port permissions.

asicC
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1. Create a file named /etc/udev/rules.d/51-usbblaster.rules.

2. Add the following lines.

SUBSYSTEMS=="usb",  ATTRS{idVendor}=="09fb", = ATTRS{idProduct}=="6010",
MODE="0666"

SUBSYSTEMS=="usb", ~ATTRS{idVendor}=="09fb", ATTRS{idProduct}=="6810",
MODE="0666"

¢ T-Core RISC-V BSP

After Quartus Prime and USB-Blaster Il driver are installed, please download the T-Core RISC-V
BSP (TCORE-RISCV-FreedomE300.tar.gz) from the web (http://T-Core.terasic.com/cd). Then,
decompress the file using command: tar -zxvf TCORE-RISCV-FreedomE300.tar.gz. So far, you can
see TCORE-RISCV-FreedomE300 file. For more information about T-Core RISC-V BSP, please
refer following table.

Table 3-3 T-Core RISC-V BSP
file or folder Description
Quartus_Project/ TCORE_FreedomE a Quartus Prime project, contains a RISC-V Core,
300 Freedom E300.
Quartus_Project/ the top file of Freedom E300. User can use it to connect
TCORE_FreedomE300/V/Freedom_  to do logic operation, etc.
E300_Wrapper.v

Toolchains prebuilt tools for compiling and debugging programs.
freedom-e-sdk/bsp/drivers contains some driver code, such as the underlying driver
code for PLIC modules, PRCI, etc.
freedom-e-sdk/bsp/include contains header files for register address and parameter of
modules, such as SPI, UART, GPIO, etc.
freedom-e-sdk/bsp/libwrap contains specific implementation of underlying library

functions related to the hardware platform.
freedom-e-sdk/bsp/env/freedom-e300 contains Terasic T-Core board supported package.
-terasic
freedom-e-sdk/software contains demonstration for reference.
freedom-e-sdk/Makefile the main Makefile for compilation and debug.

€ Download a pof file to FPGA
Follow the procedures below to write RISC-V FPGA configure data into MAX10 internal flash.

o Make sure SW2 is changed to correct location, set SW2.1=0 and SW2.2=1, as shown in
Figure 3-15 to ensure MAX10 is on JTAG chain, and RISC-V is off JTAG chain.
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JTAG CHAIN

| R

Figure 3-15 SW2 Setting

o Make sure Quartus Prime 18.1 Standard Edition is installed to the host PC.

o Connect the T-Core board (J2) to the host PC via the USB cable.

o Go to TCORE-RISCV-FreedomE300/Quartus_Project/ TCORE_FreedomE300/demo_batch
directory using command:
cd TCORE-RISCV-FreedomE300/Quartus_Project/ TCORE_FreedomE300/demo_batch.

o Execute command: sh programming_pof.sh to configure the FPGA.

4 Download bitstream to QSPI Flash

Follow the procedures below to compile a C-code project and download the generated binary file
into QSPI Flash via on-board RISC-V JTAG.

o Remove the USB Blaster Cable from T-Core to power off the board.
o Set SW2.1=1 and SW2.2=0 as Figure 3-16 to ensure MAX10 is off JTAG chain, and
RISC-V is on JTAG chain.

JTAG CHAIN

O O

Figure 3-16 SW2 Setting

Connect the T-Core board (J2) to the host PC via the USB cable.

Change the directory to TCORE-RISCV-FreedomE300/freedom-e-sdk using cd command.
Compile software by executing command: make software.

Download the binary file by executing command: make upload.

o O O O
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& ® & terasic@terasic: ~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk

terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdkS make upload
work/build/openocd/prefix/bin/openocd -f bsp/env/freedom-e300-terasic/openocd.cfg & \
Jhome fterasic/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk/work/build/riscv-gnu-toolc
hain/riscv64-unknown-elf/prefix/bin/riscv64-unknown-elf-gdb software/demo gpio/demo gp
io --batch -ex "set remotetimeout 248" -ex "target extended-remote localhost:3333" -ex
"monitor reset halt" -ex "monitor flash protect ® 64 last off" -ex "load" -ex "monito
r resume"” -ex "monitor shutdown" -ex "quit"
Open On-Chip Debugger ©.10.0+dev-00624-g09016bc (2019-87-16-15:47)
Licensed under GNU GPL v2
For bug reports, read
http://openocd.org/doc/doxygen/bugs.html
Warn : Adapter driver 'usb blaster' did not declare which transports it allows; assumi
ng legacy JTAG-only
Info : only one transport option; autoselect 'jtag'
adapter speed: 4000 kHz
Info : Altera USB-Blaster II (uninitialized) found
Info : Loading firmware...
Info : Waiting for renumerate...
Info : Waiting for renumerate...
Info : Altera USB-Blaster II found (Firm. rev. = 1.36)
Info : This adapter doesn't support configurable speed
Info : JTAG tap: riscv.cpu tap/device found: @x20000913 (mfg: ©x489 (SiFive, Inc.), pa
rt: Oxeeee0, ver: 0x2)
Info : datacount 1 progbufsize=16
: Disabling abstract command reads from CSRs.
Examined RISC-V core; found 1 harts
hart @: XLEN=32, misa=0x40001105
Listening on port 3333 for gdb connections
Listening on port 6666 for tcl connections
: Listening on port 4444 for telnet connections
3 accepting 'gdb' connection on tecp/f3333
Found flash device 'issi is251p064' (ID Ox0017609d)
E)XE)E)@E)E)E)E)@ in 72?2 ()
Info : JTAG tap: riscv.cpu tap/device found: 8x20000913 (mfg: 0x489 (SiFive, Inc.), pa
rt: Ox0e80, ver: 0x2)
JTAG tap: riscv.cpu tap/device found: 0x20000913 (mfg: ©x489 (SiFive, Inc.), part: 0x®
@00, ver: 0x2)
cleared protection for sectors 64 through 127 on flash bank ©
cleared protection for sectors 64 through 127 on flash bank ©
Info : JTAG tap: riscv.cpu tap/device found: 8x20000913 (mfg: 0x489 (SiFive,
rt: Ox0e00, ver: 0x2)
Loading section .init, size 8x74 1lma 0x20400000
Loading section .text, size 8x3c6 lma 0x20400074
Loading section .rodata, size 0x28 1ma 8x2048043cC
Loading section .data, size 8x42c 1ma 0x20400464
Info : Padding image section 0@ at 8x2048043a with 2 bytes
Info : Disabling abstract command writes to CSRs.
Info : JTAG tap: riscv.cpu tap/device found: 8x20000913 (mfg: ©x489 (SiFive,
rt: Ox0e80, ver: 0x2)
Start address 0x20400000, load size 2190
Transfer rate: 1 KB/sec, 547 bytes/write.
shutdown command invoked
shutdown command invoked
A debugging session is active.

Inferior 1 [Remote target] will be detached.
Quit anyway? (y or n) [answered Y; input not from terminal]

Remote connection closed
terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk$ |

Figure 3-17 Compile and download process
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Note: When you programming the QSPI Flash, you may encounter the error like Figure 3-18. If so,
you can execute the command: sudo apt-get install libfdtil-dev, as shown in Figure 3-19, to solve
it.

terasic@terasic: ~fDesktop/TCORE-RISCV-FreedomE300/freedom-e-sdk

terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk$ make upload
work/build/openocd/prefix/bin/openocd -f bsp/env/freedom-e300-terasic/openocd.cf
g &\
/home/terasic/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk/work/build/riscv-gnu
-toolchain/riscv64-unknown-elf/prefix/bin/riscvé4-unknown-elf-gdb software/demo_
gpiofdemo_gpio --batch -ex "set remotetimeout 248" -ex "target extended-remote 1
ocalhost:3333" -ex "monitor reset halt" -ex "monitor flash protect @ 64 last off
" -ex "load" -ex "monitor resume" -ex "monitor shutdown" -ex "quit"
work/build/openocd/prefix/bin/openocd: error while loading shared libraries: lib
ftdil.s0.2: cannot open shared object file: No such file or directory
localhost:3333: Connection timed out.

"monitor" command not supported by this target.

"monitor" command not supported by this target.

You can't do that when your target is ‘exec'

"monitor" command not supported by this target.

"monitor" command not supported by this target.
terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk$ ]

Figure 3-18 The error encountered when programming QSPI Flash

terasic@terasic: ~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk
terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdkS sudo apt-get in
stall libftdii-dev
[sudo] password for terasic:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following additional packages will be installed:
libftdi1-2
The following NEW packages will be installed:
libftdi1-2 libftdi1l-dev
@ upgraded, 2 newly installed, © to remove and 286 not upgraded.
Meed to get @ B/248 kB of archives.
After this operation, 3,052 kB of additional disk space will be used.
Do you want to continue? [Y/n] y
Selecting previously unselected package libftdii-2:amd64.
(Reading database ... 214984 files and directories currently installed.)
Preparing to unpack .../libftdi1-2_1.2-5buildl_amdé64.deb ...
Unpacking libftdi1l-2:amd64 (1.2-5build1) ...
Selecting previously unselected package libftdii-dev.
Preparing to unpack .../libftdil-dev_1.2-5buildil amdé64.deb ...
Unpacking libftdii-dev (1.2-5build1)
Processing triggers for libc-bin (2.23-0ubuntuil@)
Processing triggers for doc-base (0.10.7)
Processing 1 added doc-base file...
Processing triggers for man-db (2.7.5-1) .
Setting up libftdil-2:amd64 (1.2-5build1l)
Setting up libftdil-dev (1.2-5buildl)
Processing triggers for libc-bin (2.23-6ubuntul®)
terasic@terasic:~/Desktop/TCORE-RISCV-FreedomE300/freedom-e-sdk$ [J

Figure 3-19 Fix the error encountered when programming QSPI Flash
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o Now, you should now be able to observe the green LEDs are blinking.

o Recycle the power, you can also observe the green LEDs are blinking as the demo program
is loaded from QSPI Flash. After the reset operation, the RISC-V core will execute the
demo program. You can program new software into board with the SDK, but the FPGA
image will not be modified.
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Chapter 4

Programming the Configuration

Flash Memory

This tutorial provides comprehensive information that will help you understand how to configure
T-Core board using internal configuration mode. The MAX 10 device on the T-Core board supports
single and dual image boot. This tutorial explains the details of the internal dual image boot and
external image boot. The following sections provide a quick overview of the design flow.

Please note that if you are using the dual image boot function on the T-Core board, you will
need to solder the JP2 2-pin header (pitch 0.100" (2.54 mm)) by yourself.

Please refer to the Figure 4-1 for the JP2 position.

The settings of JP2 are described in Table 4-1.

2

JP
EEEEEEEE ‘&

LR RD

Figure 4-1 JP2 position on the T-Core board

Table 4-1 JP2 Jumper setting instructions

Open (default) Boot from image 0

‘ JP2
‘ Close

Boot from image 1

T-Core

[asic]
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4.1 Internal Configuration

The internal configuration scheme for all MAX 10 devices except for 10M02 device consists of the
following mode:

eDual Compressed Images — configuration image is stored as imageO and imagel in the
configuration flash memory (CFM).

¢ Single Compressed Image.

¢ Single Compressed Image with Memory Initialization.

¢ Single Uncompressed Image.

¢ Single Uncompressed Image with Memory Initialization.

In dual compressed images mode, you can use the BOOT_SEL pin to select the configuration
image.

The High-Level Overview of Internal Configuration for MAX 10 Devices as shown in Figure 4-2.

Configuration Data

JTAG
In-System Programming

MAX 10 Device

Internal
Configuration

Figure 4-2 High-Level Overview of Internal Configuration for MAX 10 Devices

Before internal configuration, we need to program the configuration data into the configuration
flash memory (CFM). The CFM will be part of the programmer object file (.pof) programmed into
the internal flash through the JTAG In-System Programming (ISP).

During internal configuration, MAX 10 devices load the configuration RAM (CRAM) with
configuration data from the CFM. Both of the application configuration images, image 0 and image
1, are stored in the CFM. The MAX 10 device loads either one of the application configuration
image from the CFM. If an error occurs, the device will automatically load the other application
configuration image. Remote System Upgrade Flow for MAX 10 Devices is shown in Figure 4-3.
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Reconfiguration Sample _Reconfiguration

N
A

BOOT Pin

Boot_SEL=0 l Boot_SEL=1

First Error Occurs

First Error Occurs

l Second Error Occurs I

l

Reconfiguration

Figure 4-3 Remote System Upgrade Flow for MAX 10 Devices
The operation of the remote system upgrade feature detecting errors is as follows:

1. After powering-up, the device samples the BOOT_SEL pin to determine which application
configuration image to boot. The BOOT_SEL pin setting can be overwritten by the input
register of the remote system upgrade circuitry for the subsequent reconfiguration.

2. If an error occurs, the remote system upgrade feature reverts by loading the other application
configuration image. The following lists the errors that will cause the remote system upgrade
feature to load another application configuration image:

e Internal CRC error
e User watchdog timer time-out

3. Once the revert configuration completes and the device is in the user mode, you can use the
remote system upgrade circuitry to query the cause of error and which application image failed.

4. If the second error occurs, the device waits for a reconfiguration source. If the auto-reconfig is
enabled, the device will reconfigure without waiting for any reconfiguration source.

5. Reconfiguration is triggered by the following actions:
e Driving the nSTATUS low externally
¢ Asserting internal or external nCONFIG low

e Asserting RU_nCONFIG low (Avalon-MM interface signal)
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4.2 Using Dual Compressed Images

Before using MAX 10 Dual Compressed Images feature, users must set these two image files’

Quartus Prime projects as follows:

¢ Add dual configuration IP.

e Modify Configuration Mode in device setting.

First of all, a Dual Configuration IP should be added in an original project, so that the .pof file
can be programmed into CFM through it. Here we use a demonstration named ""LEDO_BIlink'" as
an example to add Intel Dual Configuration IP to the project:

1. Open Quartus project and choose Tools > Platform Designer to open Platform Designer GUI

as shown in Figure 4-4.

(b Quartus Prime Standard Edition - C:/T-Core System CD/Dual_boot/LEDO Blink/LEDO Blink - LEDO Blink O X

File Edit View Project Assignments Processingwindow Help

IP Catalog e x
. x =
M| v & Installed IP
Vv Project Directory

System
v Library

Basic Functions

DSP

Interface Protocols

Memory Interfaces and Controllers
Processors and Peripherals

University Program
v & c h far Dars, 1D

+ Add.

available until after compilation Details

* lQuartus Prime Tc1 Console

tcl

r LEDO Blink - Run Simulation Tool
Project Navigator # Hierarchy Ylame x ‘ o Z. Launch Simulation Library Compiler
= Launch Design Space Explorer II
Entity S ign Sp p
| 1 =
& MAX 10: 10M50DAF484C7G z© Timing Analyzer
> LEDO_Blink @ ‘ 7 Advisors
c
¢ © ChipPlanner
< > ; @ Design Partition Planner
Status a8 x c Netlist Viewers
1C
Module  %Progress @ Time 11 Signal Tap Logic Analyzer
i@ @=  |n-System Memory Content Editor
121 ® Logic Analyzer Interface Editor
,}E o1 In-System Sources and Probes Editor
1 < Signal Probe Pins...
SIS » Programmer
& o ;
5 Partition Name Netlist Type oi\ JTAG Chain Debugger
i | 7m Design Partitions I
g 8 << e » Fault Injection Debugger
£ ® Top Source File System Debugging Tools
c —_—_—_—P—™————
'%ﬂ Jpcomrnen(*lation: 10f 1| for & P Catalog
e Nios Il Software Build Tools for Eclipse
AL (O] Al |4 A Filter>> |& Platform Designer |
2
=[rune ™ Meccane # Tcl Scripts...
Customize...
w .
gﬂ O.ptlons...
a License Setup...
g System Processing

”C);rnens Platform Designer System Integration Tool

(A Install Devices...

T
Voo

|Tcl Console

0% 00:00:00

Figure 4-4 Select Qsys menu and click

Please choose Library > Basic Function> Configuration and Programming > Dual

Configuration Intel FPGA IP to open wizard of adding dual boot IP. See Figure 4-5 and

Figure 4-6.
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k.3

Dual Configuration Intel FPGA IP
altera_dual_boot

& Platform Designer - unsaved.qsys® (C\T-Core System CD\Dual_boot\LEDO_Blink\unsaved.qsys) — O X
Eile Edit System Generate View Tools Help
™ IP Catalog X - = !- gys!em Eon!en!s = Address Map 23| Interconnect Requirements -f=
Y x O . = |« W System: unsaved
HEFETVF ] ~ H Use C... Name Description Export Clock  Base
—IBasic Functions
EHArithmetic X =} clk,(). Clock Source
Bridges and Adaptors =] clk_in Clock Input clk exporte,
Clocks; PLLs and Resets = clk_in_reset [Reset Input reset
EC .n.flguratlon and Programming N el Clock Output clk 0
-* Altera Config Debug Agent - clk_reset Reset Output
-* Altera Config Debug Agent Bridge =
..
..
..
..
..
..
..
-* ASMI Parallel IT Intel FPGA IP
..
<
New. .. Edit. .. + Add. . . < >
A ¥ ¥ Current filter:
.. Hierarchy Device Family = -=o
0= ﬂessages g -0
Type Path Message
< >
0 Errors, 0 Warnings Generate HDL... Finish
Figure 4-5 Select Dual Configuration Intel FPGA IP and click.
s Dual Configuration Intel FPGA IP - dual boot 0 X

Documentation

|'Block Diagram | I'Pa.rameters |
DShow signals Clock frequency: |50. 0‘ MHz
dual_boot 0
e lock
nreset
eset
avalon )
alon
altera_dual_boot

www.terasic.com

< >
Cancel
Figure 4-6 Open wizard and click Finish.
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3. Click Finish to close the wizard and return to the Platform Designer window. Choose
dual_boot_0 and click right key to select Rename it to dual_boot, and connect the clk and
nreset to clk_0.clk and clk_0.clk_reset as shown in Figure 4-7.

< Platform Designer - unsaved.qsys* (C:\T-Core System CD\Dual_boot\LEDO_Blink\unsaved.qsys) — O X
File Edit System Generate View Tools Help

TP Catalog = _ o || = System Contents 331 Address Map 23‘ Interconnect Requirements &2 =]
=| 4| @ System: unsaved Path: dual_boot. nreset
A X

Librarv A : Use C... Name Description Export Clock  Base Eny
E‘i;inﬁ?itiéons x 8 clk 0 Clock Source
[HBridges and Adaptors o=} > clkin Clock Input clk exporte,
HClocks: PLLs and Resets . = = clk_in_reset [Reset Input reset
BCon.flguramon and Programmins N — clk Clock Qutput clk 0
~# Altera Config Debug Agen - — clk reset Reset Output
* Altera Config Debug Agen = 8 dual_boot Dual Configuration...
i : clk Clock Input clk 0
- Reset Input i
. avalon Avalon Memory Mapp. .. [clk]
.
.
.
e
* ASMI Parallel II Intel F
e
flDuzl Configuration Intel
.
. v
< >
New... || Edit... + Add. .. < >
4t ¥ ¥ Current filter:
. Hierarchy 83‘ Device Fami % | - o&f B|=2
o M B -o:
‘% unsaved [unsaved. asvs¥]
: iils‘et Type Path Message
Hclk 0 | =0 ‘1 Warning ‘

=4k dual boot

! H» avalon
e clk

[ gl recet

[+ Connections

0y ‘unsaved. dual boot ‘dual,boot. avalon must be connected to an Avalon-MM master

< >

0 Errors, 1 Warning Generate HDL...  Finish

Figure 4-7 Rename and connect dual boot IP OK

4. Click “Generate HDL..” button and click Generate button when popping a window as shown
in Figure 4-8. Click Save it as dual_boot.gsys and the generation start. If there is no error in the
generation, the window will show successful as shown in Figure 4-9.
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& Save System - Platform Designer - unsaved.gsys* (C\T-Core System CD\Dual_boot\LEDO_Blink\unsaved.qsys) — O X

File Edit System Generate View Tools Help

= IP Catalog & e e _ Address Map | Interconnect Requirements 53‘ -do
= s W Svstem: unsaved Path: dual boot.nreset
3

———————— & Generation x

Librarv Base En
='Basic Functions
[FArithmetic A
[+Bridges and Adapi |- hesi

#Clocks; PLLs and Synthesis
=Configuration anc

Synthesis files are used to compile the system in a Quartus project.

i%t:ﬁi ggﬁg Create HDL design files for synthesis: |Verilog -

| DCreate timing and resource estimates for third-party EDA synthesis tools.

Create blo

. o
= 0 lcave changes? X -
" Simulation

P |
ASMT Fa.ralle‘ The simulatiol Save S¥si (ﬁ Save changes to unnamed? |y Aol

simulation—on .
Dual Confieu Save Don'tSave  Cancel [Close

Simulation sc ific
sub—directory in the specified ocutput directory.

EEREEEEEEEEEEEEEE

Follow the guidance in the generated simulation scripts about how to structure your
New. .. Edit... design’s simulation scripts and how to use the Ip—setup-simulation and >
Ip-make—simscript command—line utilities to compile all of the files needed for

N Dcvice simulating all of the IP in your design. >

- = .. -gn
@ unsaved lunsaved.a | ¢ >

= clk

4 cac
=¥ dual boot

- ai’ilon N unsaved. dual_boot |dual boot. avalon must be connected to an Avalon—MM master
- c
-

Connections

< >

0 Errors, 1 Warning Generate HDL... Finish

Figure 4-8 Generate and Save Qsys.

2 Generate Completed X

[ TUETTSS T ol eIIe TeT T5 T CUTITET T IO
@ Progress: Validating ~
@ Progress: Done reading input file

“.Warning: dual boot. dual boot: dual boot. avalon must be conn
@ Info: dual boot: Generating dual boot “dual boot” for QUARTU
@ Info: dual_boot: generating top-level entity altera_dual_boot

© Info: dual boot: “dual boot” instantiated altera_dual boot

@ Info: rst_controller: “dual boot” instantiated altera_reset
© Info: dual_boot: Done “dual_boot” with 3 modules, 7 files

@ Info: gsys—generate succeeded.

© Info: Finished: Create HDL design files for synthesis b
< >

4, Generate: completed with warnings.

Figure 4-9 Generate completed.

5. Click Close and Finish to return to the Quartus window and add the dual_boot gsys into the top
file as shown in Figure 4-10, and add the dual_boot.qip file to the project and save.
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B dual_boot ud (
Lclk_clk
.reset_reset_n (1°b1)

(MAX10_CLK1_50),

clk.clk

// reset.reset_n

Figure 4-10 Add the dual_boot module in the top file.

Secondly, the project needs to be set before the compilation. After adding dual_boot IP successfully,
please set the project mode as Internal Configuration mode, detailed steps are as follows:

1. Choose Assignments > Device to open Device windows shown in Figure 4-11.

(b Device K

Device Board

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Available devices' list

Eamily: MAX 10 (DA/DF/DC/SA/SC) 2 Package: FBGA @

Device: All = Pin count: Any @

Target device Core speed grade: Any -

Auto device selected by the Fitter Name filter: ‘

(® Specific device selected in 'Available devices' list Show advanced devices

Other: nfa Device and Pin Options... |

Available devices:

Name Core Voltage LEs Total 1/Os GPIOs Memory Bits Embedded multiplier 9-bit *
10M50DAF256C8GES 1.2V 49760 178 178 1677312 288
10M50DAF25617G 1.2V 49760 178 178 1677312 288
10M50DAF484C6GES 1.2V 49760 360 360 1677312 288
10M50DAF484C7G 1.2V 49760 360 360 1677312 288
AAAAAAAAAAAAAAA NS ANTEN 2EN 2&n 1877219 Q00 1
< >
Migration Devices... O migration devices selected

Figure 4-11 Open Device window...

2. Click Device and Pin Opinions to open the Device and Pin Opinions windows, and in the
Configuration tab, Set the Configuration Scheme to Internal Configuration and the
Configuration Mode to Dual Compressed Images. Check the Option of Generate
compressed bitstreams. shown in Figure 4-12.
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(&b Device and Pin Options - LEDO Blink X

Category:

General
Configuration
Programming Files
Unused Pins
Dual-Purpose Pins
Capacitive Loading
Board Trace Model
1/O Timing

Voltage

Pin Placement
Error Detection CRC
CvP Settings

Partial Reconfiguration

Specify the device configuration scheme and the configuration device.

Configuration scheme: |Internal Configuration v

Configuration mode: | Dual Compressed Images (512Kbits UFM) v

Configuration device
Auto
Use configuration device:
Device Options...

Configuration device 1/O voltage:

[] Force VCCIO to be compatible with configuration I/O voltage

VID Operation mode

Configuration pin: Configuration Pin Options...

Generate compressed bitstreams

Active serial clock source:

Enable input tri-state on active configuration pins in user mode

Description:

Specifies the configuration mode used with the configuration scheme for configuring the device.

Reset

OK Cancel Help

3. Choose OK to return to the Quartus window. In the Processing menu, choose Start
Compilation or click the Play button on the toolbar to compile the project, generate the

new .sof file.

4. Use the same flow to add the Dual Configuration IP into other project LED1_Blink to generate

Figure 4-12 Set Dual Configuration Mode

the new .sof file by internal configuration mode.

Finally, so far, we have successfully obtained two image .sof files for dual boot demo according to
previous steps. This section describes how to generate .pof from .sof files with the internal
configuration mode and program the .pof into configuration flash memory (CFM) through the

JTAG interface.
l. Convert .SOF File to .POF File

1. Choose Convert Programming Files from the File menu of Quartus Prime to open new

window, as shown in Figure 4-13.
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(k Quartus Prime Standard Edition - C:/T-Core System CD/Dual_boot/LEDO_Blink/LEDO Blink - LEDO_Blink
Eile Edit View Project Assignments Processing Tools Window Help

New... Ctrl+N r S EED DrEES QA0 G 9
¥ Qpen.. Cul+o o ledo_blink.v o
Close Cl+F4 Beor == nitm 0w B EC
s New Project Wizard... g% /7
* Open Project... Ctri+J 34 .
. 35 @module LEDO_B1ink(
Save Project 36
Close Project 37 [//////// Clocks /////////
38 input ADC_CLK_10,
H Save ctrl+s 39 input MAX10_CLK1_50,
40 input MAX10_CLK2_50,
Save As... 41
@ Save All Culsshiftrs |22 44564////[KEY éf///'(éé/
‘ ‘ 42 :
Eile P rties...
SR 4s 111111117 W 111111111
Create / Update » ig nput [ 3:0] SW,
Export... 48 /11111117 LED [[/1//11]
I Convert Programming Files... ] gg output L 3:0] LED,
m Pageseun- i1 (L1111 5830 (1111111
& Print Preyiew
#=% Print... Cirl4pP ot
r
Recent Files 4
Recent Projects 4
[ Exit Alt+F4 rtitions v 1. '} The selected partitions alread
[=1
z Al 9] A |4 A ilter B8 Find.. | 88 Find Next

Figure 4-13 Select Convert Programming Files and click

T-Core
User Manual

[asic]

www.terasic.com

Select Programmer Object File (.pof) from the Programming file type field in the dialog of
Convert Programming Files.

Choose Internal Configuration from the Mode filed.
Browse to the target directory from the File name field and specify the name of output file.

Click on the SOF data in the section of Input files to convert, as shown in Figure 4-14.
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[T Convert Programming File - C:/T-Core System CD/Dual_boot/LEDO_Blink/LEDO_Blink - LEDO_Blink

- O X
Eile Tools window Search altera.com [ ]
~

Specify the input files to convert and the type of programming file to generate.
You can also import input file information from other files and save the conversion setup information created here for
future use.

Conversion setup files

Open Conversion Setup Data... Save Conversion Setup...
Qutput programming file
Programming file type: I Programmer Object File (.pof) ] @
Options/Bootinfo.. | Configuration device: EPCE16 Mode: Internal Configuration @ I
File name: I ‘dualiboot.pof ] ‘
Advanced... Remote/Local update difference file: NONE

Create Memory Map File (Generate dual_boot.map)
Create CvP files (Generate dual_boot.periph.pof and dual_boot.core.rbf)

[] Create config data RPD (Generate dual_boot_auto.rpd)

Input files to convert

File/Data area Properties tart Addres Add Hex Data

SOF Data Page O <auto>

Add Sof Page
Add File...
Remove
Up

Down

Properties

Figure 4-14 Dialog of Convert Programming Files and setting

6. Click Add File and select the LEDO_blink.sof to be the sof data of Page 0.

7. Click Add Sof Page to add Page_1 and click Add File, Select the LED1_blink.sof to be the .sof
data of Page_1 as shown in Figure 4-15.

8. Click Generate.

These project files can be found in the CD directory: \Demonstrations\Dual_boot\
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Il Convert Programming File - C/T-Core System CD/Dual_boot/LEDO_Blink/LEDO Blink - LEDO_Blink - [} X
File Tools Window
¥ s "
future use. ~
Conversion setup files
Open Conversion Setup Data... Save Conversion Setup...
Output programming file
Programming file type: |Programmer Object File (.pof) =
Options/Bootinfo.. = Configuration device: EPCE16 Mode: Internal Configuration <
File name: |dual_b001.p0f
Advanced... Remote/Local update difference file: NONE
Create Memory Map File (Generate dual_boot.map)
Create CvP files (Generate dual_boot.periph.pof and dual_boot.core.rbf)
[] Create config data RPD (Generate dual_boot_auto.rpd)
Input files to convert
File/Data area Properties tart Addres Add Hex Data
v SOF Data Page_0 <auto> Add Sof Page
LEDO_Blink.sof T0M50DAF484
v SOF Data Page 1 <auto> Add File...
LED1_Blink.sof 10M50DAF484
- Remove
Up
Down
Properties
v

Figure 4-15 Add sof page and sof file
1. Write POF File into the CFM Device

When the conversion of SOF-to-POF file is complete, please follow the steps below to program the
MAX 10 device with the .pof file created in Quartus Prime Programmer.

1. Choose Programmer from the Tools menu and the Chain.cdf window will appear.

2. Click Hardware Setup and then select the DECore[USB-*] as shown in Figure 4-16.
3. Click Add File and then select the dual_boot.pof.
4

Program the CFM device by clicking the corresponding Program/Configure and Verify box,
as shown in Figure 4-17.

5. Click Start to program the CFM device.

Now, you can set the BOOT_SEL by JP2, you will find if you open JP2 (BOOT_SEL = 0), the
LEDO Blink function would show. Power off the board, insert the jumper to JP2 (BOOT_SEL = 1),
then power on, you would find the LED1 Blink function show.
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D Hardware Setup *

Hardware Settings JTAG Settings

Select a programming hardware setup to use when programming devices. This programming

hardware setup applies only to the current programmer window.

Currently selected hardware: | T-Core [USE-1] w7
Available hardware items

Hardware Server Port | Add Hardware. .. |

T-Core Local USE-1

Remove Hardware

Close

Figure 4-16 Hardware setup window

O3 Programmer - G:/tmp/ T-core/cd/Demonstration/Dual_boot/LEDO_Blink/LEDO_Blink - LEDO_Blink - [LEDO_Blink.... — O >

Search altera.com ‘.

File Edit WView Processing Tools Window Help

;.HardwareSEtup... T-Core [USB-1] Mode:  JTAG - ngress:’ ]

[] Enabile real-time ISP to allow background programming when available

wh geart File Device Checksum Usercode Program/ || | Verify | Blank- Examine
Configure Check
h stop dual_boot pof 10MS0DAF484 DEDCEB65 00277542 [l
8 Auto Detect CFMD O
CFM1 ]
X Delete UFM O
M addFile...
ar Change File... < z
M
b save File
I* Add Device...
Tol . .
Bop ] || ——H A —
TEI’DDWH ....------.
10M50DAF 434
TDO
4
L
Figure 4-17 Programmer window with dual_boot.pof file
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Chapter 5
USB Blasfter Il Cable Feature

The additional feature of T-Core is that it can be used as a USB blaster 1l to allow users to program
other Intel FPGA boards from the host PC. As shown in Figure 5-1, users can connect to the
external JTAG header (J1) of the T-Core using a flat ribbon cable. Then, use this cable to connect to
other FPGA boards with 2x5 pin JTAG header for JTAG programming(See Figure 5-2).

r—

B

¥ External JTAG
Header

~
[ st

Figure 5-2 Using T-Core board as an USB Blaster Il cable
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As shown in Figure 5-3, once the T-Core is connected to the JTAG interface of the external FPGA
board, the T-Core board automatically detects the connection and switches the JTAG chain from the
Intel MAX10 FPGA to the external JTGA header, and connected to the JTAG interface of the
external FPGA board. Implement a USB blaster Il function.

External JTAG
Header

JTAG_Blaster_ PROC_RST_n

®—» To external
JTAG interface

Mini USB
Connector

MAX10_JTAG

MAXI| <max 10
EPM570GF100 rPel

Figure 5-3 The auto-switch JTAG circuit of the T-Core board

In addition, users should note that for externally connected JTAG interface, the T-Core can
support 1/0 standard voltage range from 1.2V to 3.3V. If it is out of this range, it may not be
able to work properly or cause damage.

The following example demonstrates that use the T-Core to connect the JTAG interface of the
Terasic's DE10-Pro Stratix 10 development board and program .sof file into the FPGA via JTAG
interface.

1. Connect the flat ribbon cable to the J1 of the T-Core board, as shown in Figure 5-4. The red line
represents the connection line of pin 1, which needs to be connected to the pin of J1.

Figure 5-4 The flat ribbon cable connected to the T-Core board
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2. Connect the other end of the flat ribbon cable to the 2x5 JTAG header on the DE10-Pro board,
see Figure 5-5.

J2
USB Blaster
Connector

Figure 5-5 The flat ribbon cable connected to the T-Core board
3. Using mini USB cable to connected J2 of the T-Core board and the host PC.
4. Power the DE10-Pro board.

5. Open the Quartus programmer on the host PC, press "Hardware Setup" and select T-Core
[USB-*]. Then press "Auto Detect" and the Stratix 10 FPGA device on the DE10-Pro will
appear in the window, as shown in Figure 5-6.
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& Programmer - [ChainZ.cdf]* - O -4

Eil= Edit View Processing Jools Window Help El ﬁ
i Hardware Setup.. || T-Core [USE-1] Mode: | ITAG - Progress: ]
Enable real-time I5P to allow background programming when available

T File Device Chacksum Usercode Program/  Verify Blank-  Examine
= Botant Configure Check
wiigio, “nones 15X2B0HUZ 00000000  <nones

ﬂ.ﬁutﬂ Detect
X Delete

™ add File..
i q L3

™ Change File

r* add Device..

o
-
lg

Papown sessssaas

15X.2B0HLU2
TDO

Figure 5-6 Using T-Core board to program the DE10-Pro

6. Select a .sof of the DE10-Pro project and download it. shows the success of the T-Core program
Stratix 10 FPGA, as shown in Figure 5-7.
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@ Programmer - [Chainl.cdf]*
Eile Edit View Processing Tools Window Help

e Hardware Setup... | | T-Core [USB-1) | Mode | JTAG

Enable real-time ISP to allow background programming when available

v

Verify  Blank-
Check

Examine

www.terasic.com

W File Device Chech L di gram/
P sant Configure
Whgiop C:fUsers/User/Downlo.. 1SX2B0HU2FS0 43634682 43634682 v
“Aulooetect
X Delete
™ addFile...
P Change File 3
WS:-;E File
7 Add Device...
o R :
up —: > :
epown :nnn.n:
1SX280HU2F50
Figure 5-7 Using T-Core board to program the DE10-Pro
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Additional Information

Revision History

2019.07 V1.0 Initial Version (Preliminary)
®  Modify the SW2 setting description for Figure 3-16.
® Change blaster name from DE-Core to T-Core

2020.01 V1.1

Copyright Statement

Copyright © 2020 Terasic Inc. All rights reserved.
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